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Read Me First

= Notes on Online Manual Usage
= How to Print

Notes on Online Manual Usage

» Reproduction, diversion or copying of any text, photo or image published in the Online Manual
(hereinafter referred to as "this guide"), in whole or in part, is prohibited.

* In principle, Canon shall change or delete the contents of this guide without prior notice to customers.
In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons.
Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion
of information in this guide, or suspension/stoppage of disclosure of this guide.

» Although the contents of this guide have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

* In principle, the descriptions in this guide are based on the product at the time of its initial sale.

» This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied
with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

7> Note

* In Windows 8, print in the desktop version.

* In Internet Explorer 9 or 10

1. Select {@} (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

* In Internet Explorer 8

1. Press the Alt key to display the menus.

Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.

* In Mozilla Firefox

1. Press the Alt key to display the menus.
Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the
menus.

2. Select Page Setup... from the File menu.

3. Select the Print Background (colors & images) checkbox in Format & Options.



How to Use the Online Manual

Symbols Used in This Document

% Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

8 Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

32 Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

7> Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

> Note

* Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"

with "press and hold."



Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Android and Google Play are either registered trademarks or
trademarks of Google Inc.

» Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

» Photo Rag is a trademark of Hahnemdhle FineArt GmbH.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

+ All other company names and products mentioned herein may be trademarks or registered trademarks
of their respective companies.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.




Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper”, "(your product's model name) 1000"

Search Tips

You can search for target pages by entering keywords in the search window.

Canon » Language
Search Tips B

Online Manual

You can see manuals of your product and applications.

Product Manuals

You can learm how to handle and operate your product.

»» Note

» The displayed screen may vary.

Searching for Functions

You can find target pages easily by entering your product's model name and a keyword for the function
you want to learn about.

Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search
* Troubleshooting Errors

You can obtain more accurate search results by entering your product's model name and a support
code.

Example: When the following error screen appears
Enter "(your product's model name) 1000" in the search window and perform a search



Cancn BN scries N

poor Code ; 1000

Paper has fun aut.
Mada Type : Plain Paper
Fage Size : Letler B.5"%11" 22¢28cm

1. Load paperinto the rear bray, 2, Pressihe printer’s Stat
button

If Emaor Parsicts

»» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions

You can find target pages easily by entering your application's name and a keyword for the function you
want to learn about.

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

You can search for reference pages described in this guide by entering your model name and a page
title.
You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search



General Notes (Quick Menu)

Quick Menu is subject to the following restrictions. Keep these points in mind.
» Refer to the Canon website for products supporting Quick Menu.

« Available functions and settings vary depending on your scanner or printer. Internet
connection is required depending on the function to be used. Internet connection fees

apply.

* In this guide, descriptions are mainly based on the screens displayed when using
Windows 8 operating system (hereinafter "Windows 8").

When Using Image Display

» When using Image Display for the first time, you must agree to the license agreement.
When you agree to the license agreement by following the procedure below, images
saved in folders subject to image analysis of My Image Garden will appear in Image
Display.

1. Click the image displayed in Image Display.

2. Read the displayed license agreement, then click | Agree.

3. The screen for selecting the folders to be subject to image analysis of My Image
Garden appears; click OK.

* When Image Display is not displayed, click L
Menu.

(Start Image Display) in the Shortcut

About Downloading My Image Garden

» To display recommended items in Image Display or to edit/print selected items, you
need to download My Image Garden. You can download My Image Garden from the
Canon website.

Internet connection is required for downloading. Internet connection fees apply.



What Is Quick Menu?

«What You Can Do with Quick Menu
« Starting Applications from Quick Menu

«Shortcut Menu Operations



What You Can Do with Quick Menu

Quick Menu consists of Shortcut Menu, which allows you to start the functions you want to
use with one click, and Image Display, which plays recommended items and others in slide
shows.

Quick Menu Screens

(1) Shortcut Menu
(2) Image Display

(1) Shortcut Menu

The menu that you mainly use. Add frequently used applications, etc. to start them with one

click. Click . (Open Main Menu) to display the Main Menu in which all functions are
displayed.

(2) Image Display

The screen in which slide shows are displayed. It is available when My Image Garden, an
application enriched with useful functions such as photo printing and scanning, is installed.

You can view the following items and images in a slide show.

* ltems of collages, calendars, etc. created automatically by the item recommendation
function of My Image Garden

* Images saved on the computer

When an item or image that you like is found, you can print or edit it with My Image Garden.

10



»» Note

Refer to "Utilizing the Item Recommendation Function" for your model from Home of
the Online Manual for the item recommendation function of My Image Garden.

Related Topic
@ Shortcut Menu
@ Main Menu

«Image Display

11



Starting Applications from Quick Menu

In Quick Menu, you can start applications, open manuals, or access the Canon website,
from the Shortcut Menu or Main Menu.

= Starting from Shortcut Menu

= Starting from Main Menu

Starting from Shortcut Menu

Click a function icon saved to the Icon Bar to start an application, etc.

»» Note

If the function you want to use is not saved to the Shortcut Menu, access it from the
Main Menu.
Refer to "Main Menu" for how to save function icons to the Shortcut Menu.

1. On the Icon Bar in the Shortcut Menu, click the function icon you want to
use.

The application starts or manual opens. Access to the Canon website starts
depending on the function icon you clicked.

»» Note

When the Icon Bar is not displayed, click an arrow displayed around . (Open
Main Menu).

12



Starting from Main Menu

All functions that can be started from Quick Menu are displayed in the Main Menu. Click a
function icon to start an application, etc.

1. In the Shortcut Menu, click . (Open Main Menu).

The Main Menu appears.

2. Click the function icon you want to use.

Canon Quick Mann

13



The application starts or manual opens. Access to the Canon website starts
depending on the function icon you clicked.

»» Note

When the function you want to use is not displayed, click [l D (Back/Next) to
display the hidden icons.

Related Topic

@ Shortcut Menu Operations

14



Shortcut Menu Operations

Add frequently used function icons and useful function icons from the Main Menu to the
Shortcut Menu to start the functions with one click. You can delete or rearrange function
icons as needed.

= Adding Function Icons to Shortcut Menu
= Deleting Function Icons from Shortcut Menu

= Rearranging the Function Icons

Adding Function Icons to Shortcut Menu

1. In the Shortcut Menu, click . (Open Main Menu).

The Main Menu appears.

2. Drag the function icon you want to add and drop it onto the Icon Bar of
the Shortcut Menu.

15



The function icon is added to the Shortcut Menu.

»» Note

You can save up to eight function icons to each side of the Shortcut Menu.
Alternatively, in the Main Menu, right-click the function icon you want to add,
then click Add to Shortcut Menu in the displayed menu to add it.

Deleting Function Icons from Shortcut Menu

1. Drag the function icon you want to delete and drop it outside the Shortcut
Menu area.

16



The function icon is deleted from the Shortcut Menu.

»» Note

Alternatively, right-click the function icon you want to delete, then select Delete
from Shortcut Menu from the displayed menu to delete it.

You cannot delete . (Open Main Menu).

Rearranging the Function Icons

1. Drag a function icon in the Shortcut Menu and drop it to the target place.

The function icon is moved to the dropped place.

17



Related Topic
@ Shortcut Menu

@ Main Menu

18



Quick Menu Screens
«Shortcut Menu
«Main Menu

«Image Display

@« Recommendation Item List

« Notification Area Icon

@ Preferences Dialog Box

19



Shortcut Menu

You can start applications, open manuals or Main Menu, or access the Canon website.

~(2)

(1) Icon Bar
(2) Open Main Menu Icon

(1) lcon Bar
Icons of saved functions are displayed.
Point to a function icon to display the function description.

Click a function icon to start the application or open the manual, or access the Canon
website.

(2) Open Main Menu Icon
Click to display the Main Menu.

Click an arrow displayed around the icon to show/hide the Icon Bar adjacent to the arrow.

In addition, right-click . (Open Main Menu) to display a menu containing the following
commands.

Open Main Menu
Opens the Main Menu. Displays in front when already opened.
Add Start My Image Garden Icon

Place a checkmark to display (Start My Image Garden) in the Shortcut Menu.
Add Start Image Display Icon

20



Place a checkmark to display A (Start Image Display) in the Shortcut Menu.
Help

Opens this guide.

Preference...

Displays the Preferences dialog box.

Quit Quick Menu

Quit Quick Menu.

»» Note

In Windows Vista, if the Windows Sidebar is displayed, the Shortcut Menu may be
hidden behind the Windows Sidebar and thus cannot be operated with a mouse. In that
case, double-click B (Quick Menu) in the notification area on the desktop to bring the
Shortcut Menu to the front.

After bringing the Shortcut Menu to the front, it is recommended that you move it to a
place where it does not overlap with the Windows Sidebar.

Related Topic

@ Shortcut Menu Operations

21



Main Menu

All functions that can be started from Quick Menu are displayed in this screen. Click a
function icon to start the application or open the manual, or access the Canon website.

To display the Main Menu, click . (Open Main Menu) in the Shortcut Menu.

Canan Quick Mann

(1
(2
(3
(4

Category Menu Area
Function Icon Area
Model Name Area
Button Area

~— N S S

(1) Category Menu Area

A list of functions available on Quick Menu is displayed.

(2) Function Icon Area

Icons and names of functions that can be started from Quick Menu are displayed, sorted by
category.

Up to five function icons are displayed per category. When there are six or more function
icons, click [I Il (Back/Next) to display the hidden function icons.

Point to a function icon to display the function description.

The NEW mark appears when there is new information.

In addition, right-click a function icon to display a menu containing the following commands.

22



Start

Starts the selected application, opens the selected manual, or accesses the Canon
website.

Add to Shortcut Menu

Adds the selected function to the Shortcut Menu.

(3) Model Name Area

The printer/scanner model name registered in the Preferences dialog box is displayed.
The model name display format varies depending on the registered printer/scanner.

Click to display the Preferences dialog box.

(4) Button Area
m (Preferences Dialog Box)

Displays the Preferences dialog box.
(Help)

Opens this guide.

E (Close)

Closes the Main Menu.
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Image Display

Items created automatically by the item recommendation function of My Image Garden, or
images saved on the computer are displayed in a slide show.

mage Display + Il + | X

(1) Slide Show Area
(2) Button Area

(1) Slide Show Area
Click the Slide Show area to start My Image Garden.

(2) Button Area
(Recommendation Item List)

Displays a list of items that have been created by the item recommendation function so
far.

»» Note

. (Recommendation Item List) may not be clicked while an item is being created
or in some other cases.

(Back/Next)

Click to display the previous or next item or image.
> 1] (Playback/Pause)

Plays or pauses the slide show.

ﬂ (Preferences)
Displays the following dialog box.
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You can set the slide show details, startup option, link with My Image Garden, etc.

Image Display
Transition Effect | Fade =
lenage Views | Display entire image =
Display Speed: | Madium =

[ Display Image Daplay 8t startugp

Check the button below to use the item recommendatian functian.

|Il:em Recamependation Fundion E-Etup..l

Delete all recommended items.

Dialeta All |

[ ok ][ corea

Transition Effect

Set the transition effect to apply when switching from one item or image to another in
slide shows.

Fade

Items and images gradually appear.

Slide in

Items and images slide in from one side.

Zoom

Iltems and images are zoomed in as they are displayed.

Move

Iltems and images move randomly as they are displayed.
Image View

Set the item/image view in slide shows.
You can select Display entire image or Display based on short side of image.

»» Note

This setting is not available when Zoom or Move is selected.

Display Speed
Set the speed (duration) of switching from one item or image to another in slide shows.
You can select Fast, Medium, or Slow.

Display Image Display at startup
Select this checkbox to display Image Display when Quick Menu starts.
Item Recommendation Function Setup...

Displays the following dialog box.

25



Image Display
Enable the item recommendation functian to
automatically create new recammendatians frarm

saved images.

[+ Create recommendations

o |

Select the Create recommendations checkbox to automatically create items such as
collages and calendars using information and images registered on My Image Garden.

»» Note

When Display Image Display at startup is off and Create recommendations is
on, Image Display starts once every seven days.

Delete All

Deletes all items that have been created by the item recommendation function so far.
When you click Delete All, a confirmation screen appears; click Yes.

»» Note

To delete recommended items individually, click E] (Delete mode) in
Recommendation Item List, then click © (Delete) on the item you want to delete in
the displayed screen.

Even if you delete an item, the image used for the item will not be deleted.

“ (Close)

Closes Image Display.
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Recommendation ltem List

Displays a list of items that have been created by the item recommendation function so far.
The items are sorted by year, with the date of the latest image in the item regarded as the
event date.

To display the Recommendation Item List, click (Recommendation Item List) of Image
Display. Click an item to start My Image Garden.

»» Note

(Recommendation Item List) cannot be clicked if there is no item.

(1) Year of Event Area
(2) Image Display Area
(3) Button Area

(1) Year of Event Area

The years of the events are displayed. Click E (Down arrow) to display the next year. Click
B (Up arrow) to display the previous year.

(2) Image Display Area
Items are displayed, sorted by event year. The items are listed from left to right, in
chronological order.

Click [I D (Back/Next) to display the hidden items.

27



»» Note

Point to an item to see it in a larger view.

(3) Button Area
(Back to Image Display)
Returns to the Image Display screen.
E] (Delete mode)

Switches to a screen for deleting items.

Click @ (Delete) on an item to delete it.

»» Note

You can return to Recommendation Item List by one of the following operations.
Click E] (Delete mode) at the bottom right of the screen for deleting items.
Click outside an item.

Even if you delete an item, the image used for the item will not be deleted.

Alternatively, you can delete all items via the dialog box displayed by clicking m
(Preferences) in Image Display.
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Notification Area Icon

Use 8 (Quick Menu) in the notification area on the desktop to fully utilize Quick Menu.

Right-click it to display a menu containing the following commands.

Start My Image Garden

Starts My Image Garden, if it is installed.

Start Image Display

Starts Image Display, if My Image Garden is installed.
Preference...

Displays the Preferences dialog box.

About

Displays the About Canon Quick Menu dialog box.
Quit Quick Menu

Quit Quick Menu.

»» Note

Double-click 8 (Quick Menu) to display the Shortcut Menu.

29



Preferences Dialog Box

You can register a printer/scanner model, region, language, etc.

Display the Preferences dialog box by one of the following operations.

* Right-click . (Open Main Menu) in the Shortcut Menu, then click Preference... in
the displayed menu.

* Click ﬂ (Preferences Dialog Box) displayed at the bottom of the Main Menu.

+ Click the printer/scanner model name displayed in the Registered Model Name area in
the Main Menu.

* Right-click B (Quick Menu) in the notification area on the desktop, then click
Preference... in the displayed menu.

»» Note

The information set in the Preferences dialog box may be sent to Canon when
accessing a website, etc. via Quick Menu.

Preferences

Select Model

Printer:

Scannen

Select Your Place of Residence

Regian: UsA, Canada, Labin America
Country or Region:  United States

| Sy Regian or Country Settings

Language Settings

Language: English[English)

Lagin Information

Iii Start Quick Meny when Windows starts

[ Lizs the Notices/ | pdates function

O | | Camesl | | Aboust

Select Model
Printer
Displays the printer model name. Select the printer you want to use.
Click - " to display a list of Quick Menu compatible printers installed on your computer.
Scanner

Displays the scanner model name. Select the scanner you want to use.
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Click -~ " to display a list of Quick Menu compatible scanners installed on your
computer.

»» Note

If an all-in-one inkjet printer is selected for Printer, the same printer will be
automatically selected for Scanner.

Select Your Place of Residence
Region or Country Settings

Displays the Region or Country Settings dialog box in which you can set the Region
and Country or Region.

»» Note

In Windows 8, Windows 7, and Windows Vista, a confirmation or warning dialog box

may appear.

Such dialog box appears when administrative rights are required to perform a task. If

you are logged on to an administrator account, follow the on-screen instructions.
Changes are applied when you click OK in the Region or Country Settings dialog

box.

Language Settings
Language
Displays the current language. Select the language you want to use.

Login Information
Login Settings
Displays the Login Settings dialog box. You can save the Email address and
Password registered with CANON iMAGE GATEWAY.
When you save the Email address and Password, your login information will be sent
automatically from the next time you access CANON iMAGE GATEWAY to use the
service or register a product.

»» Note

This function is available only if you have already completed the CANON iMAGE
GATEWAY user registration.

Start Quick Menu when Windows starts
Select this checkbox to start Quick Menu automatically when Windows starts.
Use the Notices/Updates function

Select this checkbox to allow Quick Menu to access the Canon website periodically and
check for update information automatically. If there is update information, the NEW mark
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appears on (Notices) or (Updates) in the Main Menu. Click the icon to display a

notice screen in which you can check or download the update information.

»» Important

In order to use this function, the following information will be sent to Canon: your
product name, OS information, regional information, language information, and
information that you have agreed to receive information periodically.

When you select this checkbox, a confirmation screen may appear. Read the contents,
and if you agree, click | Agree. If you do not agree, you cannot use this function.

OK

Applies the settings and closes the Preferences dialog box.
Cancel

Closes the Preferences dialog box without saving the settings.
About

Displays the About Canon Quick Menu dialog box.
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Troubleshooting

Printer/Scanner Does Not Appear in the List

Printers and scanners do not appear in the Select Model list of the Preferences dialog box
in the following cases.

* A Quick Menu compatible printer/scanner driver is not installed on your computer.

» The printer/scanner driver installation is not complete.

Make sure that none of the above points apply, then display the Preferences dialog box
again.

»» Note

See your printer/scanner manual for details on how to install the printer/scanner driver.
The printer/scanner driver installation may not be complete in the following cases.
The printer/scanner was not connected to your computer while installing the driver.
The printer/scanner was off while installing the driver.

The Shortcut Menu is Hidden

In Windows Vista, if the Windows Sidebar is displayed, the Shortcut Menu may be hidden
behind the Windows Sidebar and thus cannot be operated with a mouse. In that case,
double-click & (Quick Menu) in the notification area on the desktop to bring the Shortcut
Menu to the front.

After bringing the Shortcut Menu to the front, it is recommended that you move it to a place
where it does not overlap with the Windows Sidebar.
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How to Check the Version - Quick Menu -

You can check the version of Quick Menu by following the steps below.

1. Start Quick Menu.

2. Right-click . (Open Main Menu) in the Shortcut Menu, then click
Preference... in the displayed menu.
Click Il (Preferences Dialog Box) displayed at the bottom of the Main
Menu.
Click the printer/scanner model name displayed in the Registered Model
Name area in the Main Menu.

The Preferences dialog box appears.

3. Click About.

Preferences

Selact Model

Printer:

Seannern

Salaet Your Place of Residence

Region: US4, Canada, Latin America

Country or Region:  United States

| ' Region or Country Settings |

Language Settings

Languags: English{English) *

Lagin lnfarmatian

| Login Settings

[+] Start Quick Menu when Windows starts

Lse the NoticesUpdates function

[ ok | camcal | I

The version information appears.

About Canon Quick Menu
Cangn Quick Menu Version
Copyright CANGN INC. All Rights Reserved.
0K
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